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Introduction

This manual contains detailed instructions and notes on the operation and use of this product. For your safety and 

benefit, read this manual carefully before using the product. Keep this manual in a handy place for quick reference.
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Guides for This Solution

The following manuals (PDF/HTML) are available for FlexRelease CX.

FlexRelease CX Start Guide <Preparation for Utilizing the Service>

This guide is intended for administrators and end users. It describes preparations 

required for utilizing the service.

FlexRelease CX Service Quick Guide <System Overview>

This guide is intended for administrators and end users. It describes the overview of the 

FlexRelease CX system.

FlexRelease CX Operating Instructions <Port Monitor> (this guide)

This guide is intended for administrators and end users. It describes how to install/

uninstall the port monitor for FlexRelease CX to/from a client PC, how to register/delete 

the port for FlexRelease CX, and how to send a print job using a printer driver. 

FlexRelease CX Operating Instructions <iOS Application>

This guide is intended for end users. It describes how to upload/manage print jobs using 

the iOS application for FlexRelease CX on iPhone/iPad.

FlexRelease CX Operating Instructions <User’s Guide for FlexRelease CX Server>*

This guide is intended for end users. It describes how to upload/manage print jobs, and 

how to manage own user information, using FlexRelease CX Server.

FlexRelease CX Operating Instructions <Administrator’s Guide for FlexRelease CX 

Server>*

This guide is intended for administrators. It describes how to manage the storage period 

of print jobs stored in the server of FlexRelease CX and the user/device/company 

information registered in the FlexRelease CX system using FlexRelease CX Server.

FlexRelease CX Operating Instructions <Quick Start Guide for FlexRelease CX 

Embedded Print>

This guide is intended for end users. It describes how to log in to/log out of the 

FlexRelease CX system using FlexRelease CX Embedded Print installed in a device, 

and how to print/delete print jobs using the display panel of a device.

FlexRelease CX Operating Instructions <User’s Guide for FlexRelease CX Embedded Print>

This guide is intended for end users. It describes how to log in to/log out of the 

FlexRelease CX system using FlexRelease CX Embedded Print installed in a device, 

and how to print/delete print jobs using the display panel of a device.

FlexRelease CX Operating Instructions <Administrator’s Guide for FlexRelease CX 

Embedded Print>

This guide is intended for administrators. It describes how to configure and manage 

FlexRelease CX Embedded Print using FlexRelease CX Embedded Print Manager.

* HTML format
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� The guides in HTML format can be viewed with a web browser.

� Adobe Acrobat Reader or Adobe Reader is necessary to view the guides in PDF format.

How to Read This Guide

We recommend that you read this guide in its entirety to familiarize yourself with how to utilize 

the port monitor for FlexRelease CX.

Symbols

The following symbols are used in the manual to help you to identify content quickly.

This symbol indicates points to pay attention to.

This symbol indicates supplementary information that you may find helpful for completing a 

task.

This symbol indicates where to find further relevant information.

[  ]

Square brackets indicate the name of buttons or fields.
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Important

� TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW:

� THE SUPPLIER SHALL NOT BE LIABLE FOR THE RESULT OF OPERATION OF 

THIS SOFTWARE OR THE USE OF THIS DOCUMENT.

� THE SUPPLIER SHALL NOT BE LIABLE TO YOU FOR DAMAGES OR LOSS OF 

ANY DOCUMENT OR DATA PRODUCED BY USING THIS SOFTWARE.

� THE SUPPLIER SHALL NOT BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, 

INCIDENTAL OR INDIRECT DAMAGES (INCLUDING, BUT NOT LIMITED TO, 

DAMAGES FOR LOSS OF PROFITS, BUSINESS INTERRUPTION OR LOSS OF 

BUSINESS INFORMATION, AND THE LIKE) CAUSED BY FAILURE OF THIS 

SOFTWARE OR LOSS OF DOCUMENTS OR DATA, NOR FOR ANY OTHER 

DAMAGES ARISING OUT OF THE USE OF THIS SOFTWARE, IF THE SUPPLIER 

HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

� Some illustrations or explanations in this guide may differ from your product due to 

improvement or change in the product.

� The contents of this document are subject to change without notice.

� No part of this document may be duplicated, replicated, reproduced in any form, modified 

or quoted without prior consent of the supplier.

� It is possible that any document or data stored in the computer will be damaged or lost 

by user error during operation or software error. Be sure to back up all important data 

beforehand. Important documents and data should always be copied or backed up. 

Documents and data can be lost because of malfunction or human error. Furthermore, 

the customer is responsible for protection measures against computer viruses, worms, 

and other harmful software.
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Trademarks

FlexRelease CX® is a registered trademark of Ricoh Company, Ltd.

Adobe®, Acrobat®, and Reader® are registered trademarks of Adobe Systems Incorporated 

in the United States and/or other countries.

Microsoft®, Windows®, Windows Vista®, and Internet Explorer® are registered trademarks of 

Microsoft Corporation in the United States and/or other countries.

Other product names used herein are for identification purposes only and might be 

trademarks of their respective companies. We disclaim any and all rights to those marks.
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1. Introduction

This guide describes how to install/uninstall the port monitor for FlexRelease CX to/from a 

client PC, how to register/delete the port for FlexRelease CX, and how to send a print job 

using a printer driver.  

Workflow

For setting and utilizing the port monitor for FlexRelease CX, there are operations which 

require the administrator authority, and operations which are available for user authority. 

This guide describes the operations respectively by following the workflow below.

Operations for Administrators

Administrator authority is required for installing/uninstalling the port monitor for FlexRelease 

CX.

Setup

Maintenance

Installing the Port Monitor for 

FlexRelease CX
For details, see “3. Installation” on page 11.

Uninstalling the Port Monitor for 

FlexRelease CX

For details, see “6. Uninstallation” on 

page 16.



Workflow

7

2

1

3

4

5

6

7

9

8

10

11

12

13

14

15

Operations for Users

Setup

Maintenance

Z

* This operations is required when sending a print job for the first time after a client PC is 

started.

Registering the Port to a Printer 

Driver

For details, see “4. Setup of a Printer 

Driver” on page 13.

Deleting the Port
For details, see “5. Deletion of the Port” on 

page 15.

Sending a Print Job to the Server 

of FlexRelease CX

For details, see “Sending a Print Job to the 

Server of FlexRelease CX” on page 17.

Setting the User Information*
For details, see “Setting the User 

Information” on page 18.
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2. Port Monitor for FlexRelease CX

Overview of Port Monitor for FlexRelease 
CX

You can send a print job using a printer driver from a client PC to the server of FlexRelease 

CX if installing the port monitor for FlexRelease CX to the client PC (Windows only) and 

registering the port to the printer driver.

� For the overview of the FlexRelease CX system, refer to FlexRelease CX Service Quick 

Guide <System Overview>.

CPC001

Managing user 

information etc.
Server in the Cloud

Authentication of 
a company and users

Storing print jobs

Client PCSmartphone/

tablet

Editing own user 

information using 

a web browser

Viewing/printing/

deleting print jobs

iPhone iPad

Admin PC

User User

Administrator

Devices which FlexRelease CX 

Embedded Print is installed in 

and are registered to the 

FlexRelease CX system

Sending print jobs using 

a web browser/Email/iOS 

application/printer driver

Managing 

FlexRelease CX 

Embedded Print



Operating Environment

9

2

1

3

4

5

6

7

9

8

10

11

12

13

14

15

Operating Environment

The following environment is required for installing the port monitor for FlexRelease CX and 

sending a print job to the server of FlexRelease CX.

CPU Intel Core 2 Duo 1.6 GHz or higher

Memory Free space of 512 MB or more

HDD Free space of 500 MB or more

Operating System Microsoft Windows XP Home Edition (32bit)*1

Microsoft Windows XP Home Edition (64bit)*1

Microsoft Windows XP Professional Edition (32bit)

Microsoft Windows XP Professional Edition (64bit)

Microsoft Windows Vista Ultimate Edition (32bit)

Microsoft Windows Vista Ultimate Edition (64bit)

Microsoft Windows Vista Enterprise Edition (32bit)

Microsoft Windows Vista Enterprise Edition (64bit)

Microsoft Windows Vista Business Edition (32bit)

Microsoft Windows Vista Business Edition (64bit)

Microsoft Windows Vista Home Basic Edition (32bit)*1

Microsoft Windows Vista Home Basic Edition (64bit)*1

Microsoft Windows Vista Home Premium Edition (32bit)*1

Microsoft Windows Vista Home Premium Edition (64bit)*1

Microsoft Windows 7 Ultimate Edition (32bit)

Microsoft Windows 7 Ultimate Edition (64bit)

Microsoft Windows 7 Enterprise Edition (32bit)

Microsoft Windows 7 Enterprise Edition (64bit)

Microsoft Windows 7 Professional Edition (32bit)

Microsoft Windows 7 Professional Edition (64bit)

Microsoft Windows 7 Home Premium Edition (32bit)*1

Microsoft Windows 7 Home Premium Edition (64bit)*1

Windows 8 (32bit)*1

Windows 8 (64bit)*1

Windows 8 Pro (32bit)

Windows 8 Pro (64bit)

Windows 8 Enterprise (32bit)

Windows 8 Enterprise (64bit)
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*1 Windows login authentication cannot be used because the operating system cannot join a 

domain.

� Internet environment is required for sending a print job to the server of 

FlexRelease CX using a printer driver.

� The data size (300 MB) is applied to the print job generated by a printer driver. The data 

size of a print job can be confirmed in a print queue of a printer.

� For the update information of the operating environment, refer to the FlexRelease CX 

site.

Operating System

(Continued)

Windows 8.1 (32bit)*1

Windows 8.1 (64bit)*1

Windows 8.1 Pro (32bit)

Windows 8.1 Pro (64bit)

Windows 8.1 Enterprise (32bit)

Windows 8.1 Enterprise (64bit)

Windows 10 Home (32bit)*1

Windows 10 Home (64bit)*1

Windows 10 Pro (32bit)

Windows 10 Pro (64bit)

Windows 10 Enterprise (32bit)

Windows 10 Enterprise (64bit)

Windows 10 Education (32bit)

Windows 10 Education (64bit)

Printer Driver PCL 6 Driver for Universal Print

Data Size up to 300 MB (per file)
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3. Installation

This section describes how to install the port monitor for FlexRelease CX to a client PC.

Installing the Port Monitor for FlexRelease CX

� Administrator authority is required for installing the port monitor for FlexRelease 

CX.

� A tenant authentication key file is required to use Windows login authentication. 

Be sure to use the tenant authentication key file distributed by the administrator 

and place it in the same folder as the installer.

� The following conditions must be met to use Windows login authentication.

� A client PC that belongs to the domain.

� A device using Card Authentication Package V2 or Enhanced Locked Print 

NX V2 that belongs to the same domain as the client PC.

� The center administrator has configured the settings for Windows login 

authentication.

1 Log in to the FlexRelease CX system using FlexRelease CX Server.

 

� For FlexRelease CX Server, refer to FlexRelease CX Operating Instructions 

<Administrator’s Guide for FlexRelease CX Server>.

2 Click [Help].

3 Select a language.

4 Click [Download] for FRCX Port.

5 Specify a destination to save the file to, and then save the file.

6 Decompress the downloaded file.

7 Open the “setup.exe” file.

The [Welcome to the InstallShield Wizard for FRCX port] screen appears.

8 Click [Next].

The [License Agreement] screen appears. 

9 Select the check box of [I accept the terms of the license agreement], and then 

click [Next].

The [Choose Destination Location] screen appears.

10 Specify the installation path, and then click [Next].

The [Ready to Install the Program] screen appears.



3. Installation

12

3

4

5

6

7

1

2

10

11

12

13

14

8

9

15

 

� Default installation path is “C:\Program Files\FRCX port”.

11 Click [Install].

The [InstallShield Wizard Complete] screen appears.

12 Click [Finish].

 

� If necessary, the port monitor for FlexRelease CX can be overwritten by installing it 

again. For overwriting the port monitor, perform the step 1 to 12.

The following settings remain the same even if the port monitor is overwritten.

- Port setting

- User information setting

- Proxy setting

If the port monitor for FlexRelease CX is overwritten while sending a print job, the 

transmission will fail.

� The tenant authentication key file is not read when overwritten by installing.
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4. Setup of a Printer Driver

This section describes how to register the port for FlexRelease CX to a printer driver.

Registering the Port to a Printer Driver

� Install a PCL 6 Driver for Universal Print beforehand. Open the properties screen 

for the printer driver, select [Generic Model], and click [Update Now] before 

performing the following procedures.

� If utilizing a printer currently in use, add a printer for the port for FlexRelease CX. 

If registering the port for FlexRelease CX to the printer, all print jobs are sent to 

the server of FlexRelease CX. 

� The procedures to open the properties screen for a printer driver differ depending on the 

operating system of a PC. Perform the procedures accordingly instead of the steps 

described below.

1 On the desktop, click the [Start] button, and then select [Control Panel] 

→[Printers and Faxes].

2 Right-click a printer icon, and then click [Properties].

3 Click the [Ports] tab, and then click [Add Port].

4 Select [FRCX port], and then click [New Port].
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5 Specify the following settings.

� Enter all the setting items.

� The port setting cannot be changed after the setting is registered by clicking [OK] 

in step 6.

6 Click [OK].

� If the entered port name has been already registered, an error message appears.

7 Click [Close].

8 Click [Apply].

Tenant ID Enter a Tenant ID.

� Tenant ID is case sensitive.

Port Name Enter a port name in up to 62 characters.

� The default port name is “<Tenant ID>@FlexReleaseCX”.

� “,” (comma), “\”, “/”, and a space cannot be used in a port 

name.
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5. Deletion of the Port

This section describes how to delete the port for FlexRelease CX.

Deleting the Port

� The port can only be deleted by the user who registered it.

1 On the desktop, click the [Start] button, and then select [Control Panel] 

→[Printers and Faxes].

2 Right-click a printer icon, and then click [Properties].

3 Click the [Ports] tab, and then select the check box of [FRCX Port] in the port list.

4 Click [Delete Port].

5 After a confirmation message appears, click [Yes].

6 Click [OK].

 

� The port cannot be deleted if the port is registered to a printer driver or when sending a 

print job using the port.
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6. Uninstallation

This section describes how to uninstall the port monitor for FlexRelease CX from a client PC.

Uninstalling the Port Monitor for 
FlexRelease CX

� Administrator authority is required for uninstalling the port monitor for 

FlexRelease CX.

1 Close all the applications currently running on a client PC.

2 On the desktop, click the [Start] button, and then select [Control Panel] →[Add or 

Remove Programs].

3 Select [FRCX Port], and then click [Remove].

� The button name may differ from [Remove] depending on the operating system.

4 Click [Yes].

� If uninstalling the port monitor when the port for FlexRelease CX is registered to a printer 

driver, the port setting is cleared and “[File:]Port” is set automatically instead.

� If the port monitor for FlexRelease CX is uninstalled while sending a print job, the 

transmission will fail.
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7. Sending a Print Job

Sending a Print Job to the Server of 
FlexRelease CX

This section describes how to send a print job to the server of FlexRelease CX using a printer 

driver registered with the port for FlexRelease CX. 

1 On the [File] menu of an application, select [Print].

2 Select a printer, and then specify print settings.

3 Click [OK].

If the authentication succeeds, the print job is sent to the server of FlexRelease CX.

� The user information setting screen appears in the following cases.

- Sending a print job for the first time after a client PC is started.

- [Save User Information] had not been selected when user information was set. 

- Authentication failed.

For details on how to enter the user information, see “User Information Setting 

Screen” on page 18.

� If a proxy server is used in the system environment, the proxy connection setting 

screen appears in the following cases.

- Sending a print job for the first time after a client PC is started.

- [Save the password] had not been selected when user information was set.

- Authentication failed.

For details on how to enter the information on the proxy connection setting screen, 

see “Proxy Connection Setting Screen” on page 20.

� It may take time to send a print job depending on the internet connection 

environment.

� Transmission may fail if sending a print job in an unstable internet connection. 

� The authentication information specified in a printer driver will be invalid.
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Setting the User Information

This section describes how to set a user name and password on the user information setting 

screen and the proxy connection setting screen.

User Information Setting Screen

The user information setting screen appears in the following cases.

� Sending a print job for the first time after a client PC is started.

� [Save User Information] had not been selected when user information was set. 

� Authentication failed.

Entering a User Name and Password and Logging In

1 Enter a user name in [User Name].

� [Tenant ID] cannot be set.

2 Enter a password in [Password].

3 Click [Login].

If the authentication succeeds, the print job is sent to the server of FlexRelease CX.

� If selecting the check box of [Save User Information] and then clicking [Login] in step 3, 

the entered user name and password are saved. The saved values are used from the 

next connection.
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If the authentication failed, the user information screen appears. Enter the correct user 

information.

Logging In Using Windows Login Authentication

If a tenant authentication key file has been saved, you can use Windows login authentication.

� A tenant authentication key file must be installed to use Windows login 

authentication.

� A client PC must belong to the domain to use Windows login authentication.  Use 

an operating system that can join a domain.

1 Select the [Authenticate with Logged On Windows User] check box.

2 Click [Login].

If the authentication succeeds, the print job is sent.

� If the [Authenticate with Logged On Windows User] check box is selected in step 1, the 

displayed user name and password will not be used.

� If the [Save User Information] check box is selected and then [Login] is clicked in step 2, 

the Windows login authentication information is saved. The saved values are used from 

the next time a print job is sent.
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Proxy Connection Setting Screen

If a proxy server is used in the system environment, the proxy connection setting screen 

appears in the following cases.

� Sending a print job for the first time after a client PC is started.

� [Save the password] had not been selected when user information was set.

� Authentication failed.

� Set the proxy server setting using the menu of Internet Explorer ([Tools] →[Internet 

Options] →[Connections] tab →[LAN Settings]).

Specify [Use automatic configuration script] in [Automatic configuration], or [Proxy 

server].

The operation of [Automatically detect settings] in [Automatic configuration] is not 

guaranteed.

� Settings required on the proxy connection setting screen differ depending on the system 

settings. For details, ask the administrator.

1 Enter a proxy user name in [User Name].

2 Enter a proxy password in [Password].

3 Click [OK].

� If selecting the check box of [Save the password] and then clicking [OK] in step 3, the 

entered password is saved. The saved value is used from the next connection.

� If the authentication failed, the proxy setting screen appears. Enter the correct 

information.
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8. Error Display

This section describes the error messages displayed when installing the port monitor for 

FlexRelease CX or when sending a print job using a printer driver registered with the port for 

FlexRelease CX.

If errors which are not described appear, note the error, and then consult the customer 

service.

Error Messages

When Installing the Port Monitor for FlexRelease CX

Messages Causes Solutions

Unable to run the installer 

because of insufficient 

access rights.

� Installation is performed 

by a user who does not 

have administrator 

authority.

� Operate with 

administrator authority.

The specified path is invalid. � The number of entered 

characters exceeds the 

maximum number of 

characters that can be 

specified for the 

installation path. 

� Enter a valid path.

The spooler service’s 

[Startup Type] is disabled. 

Perform setup after 

changing it to either 

[Automatic] or [Manual].

� [Startup Type] setting of 

the Print Spooler service 

is set to [Disabled].

� Perform the installation 

after setting [Startup 

Type] to [Automatic] or 

[Manual]. 

Unable to start the spooler 

service. Restart the OS.

� The Print Spooler service 

cannot be started.

� Perform the installation 

after restarting the client 

PC. 

Retry as a user with 

administrator authority.

� When the User Account 

Control function is active, 

a user who does not have 

administrator authority 

performed installation.

� Operate with 

administrator authority.
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When Registering/Deleting the Port

Messages Causes Solutions

This port name already 

exists.

� The entered port name is 

already registered.

� Enter a unique port name.

The port name is invalid. 

Enter a valid port name and 

try again.

� Port name is not entered.

� More than 62 characters 

are entered.

� The entered port name 

includes characters which 

cannot be used in a port 

name.

� Enter a port name in up to 

62 characters.

� Enter a port name in 

characters which can be 

used in a port name.

Tenant ID is invalid. Try 

again by entering a valid 

tenant ID.

� Tenant ID is not entered.

� The entered tenant ID is 

not correct.

� Enter a correct tenant ID.

There is nothing to configure 

for this port.

� [Port Configuration] is 

clicked to change the port 

setting.

� The port setting cannot be 

changed. To change the 

setting, delete the port 

first, and then set up a 

new port.
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When Sending a Print Job

Messages Causes Solutions

The file size is too large. 

Files to be uploaded should 

be less than 300MB.

� The file size of a print job 

to be sent is over 300 MB.

� Send a print job in size of 

not more than 300 MB.

Up to 50 files could be 

registered.

� 50 print jobs are already 

stored in the server of 

FlexRelease CX.

� Print/delete print jobs 

stored in the server of 

FlexRelease CX before 

sending another print job.

Not connected to the 

network.

� Connections with the 

server of FlexRelease CX 

failed.

� Check the network 

settings.

A timeout has occurred. � Timeout occurred in the 

connections with the 

server of FlexRelease 

CX. 

� Check the network 

settings.

� Send a print job again 

after a while.

A communication error has 

occurred.

� Unexpected error 

occurred in the 

connections with the 

server of FlexRelease 

CX.

� Check the network 

settings.

� Send a print job again 

after a while.

Unable to connect to the 

service.

� The server of 

FlexRelease CX is down.

� Unexpected error 

occurred in the server of 

FlexRelease CX.

� Consult the customer 

service.

Failed to upload the file. � Unexpected error 

occurred in the port 

monitor.

� Consult the customer 

service.
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9. Appendix

Limitations

� Registration of multiple ports is guaranteed up to five.

� Do not set the printer driver registered with the port for FlexRelease CX as a shared 

printer.

� Sending of print jobs from a remote desktop is not guaranteed.

� Sending of a print job is not guaranteed if a user logged out of Windows while sending a 

print job.

� Operations are not guaranteed if the Windows operating system is upgraded 

(overwritten) when the port monitor for FlexRelease CX is installed (Ex: when the 

operating system is upgraded from Windows XP to Windows Vista).

� Operations are not guaranteed if the edition of the Windows operating system is 

upgraded when the port monitor for FlexRelease CX is installed (Ex: when the edition of 

the operating system is upgraded from Windows 7 Ultimate Edition to Windows 7 

Enterprise Edition).

� Sending of print jobs using a printer driver other than a PCL 6 Driver for Universal Print 

is not guaranteed.

� If sending a print job for printing multiple copies without sort setting, the number of copies 

cannot be changed using FlexRelease CX Embedded on an MFP.

� It may take time to send a print job depending on the internet connection environment.

� Transmission may fail if sending a print job in an unstable internet connection.

� Printing cannot be canceled if [Printing] is displayed for the status of a print job in a print 

queue of a printer.

� When the User Account Control function is active, if sending a print job using the 

application which is ran as an administrator, the user information setting screen/proxy 

connection setting screen/error displays appear behind the application window.

� Restart the Printer Spooler service or the client PC for changing the user information 

saved by selecting [Save User Information] on the user information setting screen or 

[Save the password] on the proxy connection setting screen.
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